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Extended Order Entry 

Extended Order Entry is an enhanced replacement for the Sage Order Entry screen. It provides you with 

more functionality while entering an order, and fast access to order, customer, and item information. 

The following screens show some of the extra features provided by the Extended Order Entry screen: 

Sage Order Entry screen TaiRox Extended Order Entry screen 

 

 

Click the following links for details on each Extended Order Entry feature: 

SmartFinder – Orders Find orders quickly for a customer. 
SmartFinder – Customers Find a customer quickly from a name, description, phone number or 
address.  
Item Finder (SmartFinder – Items) Find an item quickly from partial words. Show additional item 
columns such as price, quantity and comments. Search also by manufacturer’s item number with the 
Enterprise version of Productivity Tools. 

SmartFinders provide fast, browser-like search capabilities for looking up data on the Order Entry 
screen. They search more fields than the Finder and search in all text fields at once. For 
example, search for “Seattle” if you think that the customer or contact is in Seattle. 

Line Finder Quickly find a detail line in a large order by item number, item description, item 

comments, picking sequence, location, manufacturer, or other item fields. 
Customer Inquiry (button left of the Customer Name field) provides complete customer data, including 
receipts, refunds, order, invoices, IC contract pricing, ship-to addresses, etc. using the TaiRox 
Extended Customer Inquiry window instead of the Sage Customer Inquiry screen. 
Calculate Expected Ship Date and Deliver By Date Use the Business Days and Non-Business Days 
optional field in the Productivity Tools Options program to calculate shipment and delivery dates. 
Customer Optional Fields Display any customer optional fields on the Extended Order Entry screen. 
Require PO Number Optionally require PO numbers on orders for all or selected customers. 
Display and Edit Optional Fields in the Order Entry Detail Grid Optional fields appear as grid columns. 
Other Restrictions and Preferences set in TaiRox Productivity Tools Options Select more data entry 
control options in the TaiRox Productivity Tools Options program: 

o Warn if a PO is duplicated on an order or shipment. 

o Show unit of measure totals on the Extended Order Entry screen. 
o Include the discount percent set on order lines and for the order as a whole. 
o Prevent orders and one-time shipments from being posted if the Ship-To Location is blank. 
o Prevent users from entering or changing ship-to addresses. 
o Require a ship-to phone number on orders and shipments. 
o Default the quantity committed on orders to the quantity ordered for select customers. 
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Margin and Recent Cost Columns Add 4 margin and markup columns to the item display grid. Click 
on a button to display margin and markup for the whole order. 
Edit Kit Details Using the Components Button Configure kits in an order without cluttering up master 
kit definitions. Add items, delete items and modify quantities. Choose whether or not to re-calculate 
the unit price. 
Using the Enhanced BOM Components Popup View component quantities on hand and quantities 
available at the current location, as well as component quantities on sales order and quantities 
committed at the current location and at all locations.  
Quick Forms Printing (O/E Forms) Print a number of order-related forms, without posting an order or 
navigating to another window. 
Print Picking Slips Fast Streamline the printing of picking slips, in situations where large numbers of 
these are to be printed as quickly as possible. 
Quick PJC Entry Contract, Project and Category codes will default to the previous line's entries when 
inserting new lines. 
Prepayments lets you view order prepayments entered in Order Entry or in Accounts Receivable. 
Create Purchase Orders in a flexible and robust way, previewed and with many options. 
Ship by Picking Sequence and Filter Items Enter quantities picked for a large number of items by 
sorting items in picking sequence and restricting the item range – for example, by ship-via code. 
Order from History Add items to new orders for a customer based on previous orders. 
Item Quantities Display quantities available at other locations or in other companies while entering an 
order. 
BOM or Kit - Use as Default Use the default number when a BOM or Kit is added to an order. 
Backorders Display all items currently on backorder for the current customer. 
Update Order Change Kit and BOM numbers, expected ship dates, item prices, addresses, and 
deliver-by dates. Commit and uncommit quantities, substitute one item for another, change 
salesperson code, zero quantities that are not in stock, and change item location. 

Note:  You may need to maximize the Extended Order Entry screen to see all of the Sage 300 and 
TaiRox Productivity Tools buttons at the bottom of the screen. 
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SmartFinder – Orders 

Click the Order Number button to open the SmartFinder for searching orders.    

• Enter part of a name or address (or order description or reference) and click the Find button. 

• Double-click the order to select it and return you to the Order form. 

Search:  

• Enter one or more words or word fragments in the entry field to search multiple tables and fields.  

• You can filter by order type and include completed and on-hold orders. 

• Search returns records which contain the search string in any of the searched fields – for 
example, one record may have “Royal” in the name, where another may have it in the address 
field. Both will be displayed. 

o Using multiple words in the search? Enter "300 Main" and the search will find entries "300 
Main Street" as well as "123 Main Street, Suite 300".  

o Searching for a phone number? Enter the phone number segments separated by blanks. 
Enter "451 8991" and the search will find "(451) 555-8991" as well as "(408) 451-8991". 

Note: 

o All of the word fragments must be present in one of the fields being searched. (For example, 

if you searched for “Ross Blvd”, you will not see an order where “Ross” is in the Customer 
Name field and “Blvd” is in the Address 1 field.) 

o Addresses (e.g. the Bill-To addresses) are treated as a single field. 

Display:  

• The top grid displays the orders matching the search criteria. Double-click to select an order. 

• The bottom grid displays the details of the order highlighted in the top grid. 

• Click the Bill-To Address column heading or double-click the address to launch Google Maps 
with the bill-to address. You can also check the locations of Ship-To addresses. 

• Double-click email addresses (such as the Bill-To Contact E-mail) to create new emails. 
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SmartFinder – Customers 

Click the Customer Number button to open the SmartFinder for searching customers.    

• Enter part of a name or address (or contact phone or email address) and click the Find button. 

• Double-click the customer to select it and return you to the Order form. 

Search:  

• Enter one or more words or word fragments in the entry field to search multiple tables and fields.  

• You can filter to retrieve active customers only and active ship-to locations only. 

• Search returns customers and ship-to location records which contain the search string in any of 
the searched fields – for example, one record may have “Royal” in the name, where another may 
have it in the address field. Both records will be displayed. 

o Using multiple words in the search? Enter "300 Main" and the search will find entries "300 
Main Street" as well as "123 Main Street, Suite 300".  

o Searching for a phone number? Enter the phone number segments separated by blanks. 
Enter "451 8991" and the search will find "(451) 555-8991" as well as "(408) 451-8991". 

Note: 

o All of the word fragments must be present in one of the fields being searched. (For example, 

if you searched for “Ross Blvd”, you will not see a customer where “Ross” is in the Customer 
Name field and “Blvd” is in the Address 1 field.) 

o Addresses (e.g. the Bill-To addresses) are treated as a single field. 

Display:  

• The top grid displays the customers matching the search criteria. Double-click to select a 
customer. 

• The bottom grid displays the ship-to locations that match the search criteria.  

Note that the ship-to locations may not be related to the customer records displayed in the top 

part of the screen. Ship-to locations appear only if they contain the search string. 

• Click the Address column heading or double-click the address to launch Google Maps with the 
bill-to address. You can also check the locations of ship-to addresses. 

• Double-click email addresses (such as the Bill-To Contact E-mail) to create new emails. 
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Item Finder (SmartFinder – Items) 

Click the Item Finder button under the item grid to open the SmartFinder for items. 

 

 

The Item Finder provides several item search options and displays search results in a selection grid with 
columns such as price, description, quantity available (current and all locations) and comments. Often, 
Order Entry users select between similar items based on these columns.  

 

• The Item Finder appears with the “Search” choice selected by default on the Items tab. This is the 
most common way to look up items. 

o Type a partial item description or item number in the text field, optionally select Active Items 
Only, and press Enter to immediately search for items. 

• Alternatively, select a different “Find Items By” choice. For example, you can choose “Show All 
Records” and specify a range of item numbers, structure codes, categories, or account sets using 
the range fields. You can specify more selection fields using Additional Criteria. 

 

Notes: 

• The above search screen displays two tabs for looking up inventory items – Items and 
Manufacturer’s Item Number – which let you search for I/C item numbers or for manufacturer’s 
item numbers. 

Search for manufacturer’s item numbers is a Productivity Tools Enterprise feature.  
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The Manufacturer’s Item Number tab will not appear unless you have a license for the Enterprise 
version of Productivity Tools. 

• If you do not select the SmartFinder “Search” option, you can select up to four item field ranges – 
by item number, status, structure code, category code, and account set code. 

• The item price is the quantity zero price for that customer. 

• The Item Finder also displays all columns that are in the standard Sage Finder. You can choose 
which columns appear in the Item Finder by selecting File > Settings from the Item Finder menu. 

• Selecting an item inserts a new row into the order entry grid.  

Searching for Inventory Control Item Numbers on the Items Tab 

The Item Finder on the Items tab provides 7 search options: 

  

• Search (most common option) – to search for words or word fragments in item text fields (such 
as the item number, item description, structure code, category, price list, picking sequence, and 
comments). This search works like the Order Number and Customer Number SmartFinders. 

The “Search” choice automatically searches in all fields that appear as columns in the grid.  

• Show All Records – to select items from all item records based on ranges of Item Number, 
Structure Code, Category, and Account Set Code and on item Status. You can also specify 
additional selection criteria using more item fields. 

• Item Number – to select items using part of the item number. You can refine your selection 
based on ranges of Item Number, Structure Code, Category, and Account Set Code, select items 
by item status, and specify additional selection criteria using more item fields. 

 

Search by Item Number, Description, Structure Code, Category and Account Set Code also let 

you specify a search value that the item starts with or contains.  

• Description – to select items with descriptions that begin with or contain a string of characters. 
You can refine your selection based on ranges of Item Number, Structure Code, Category, and 
Account Set Code, select items by item status, and specify additional selection criteria using 
more item fields. 

• Structure Code – to select items with structure codes that begin with or contain a string of 
characters. You can refine your selection based on ranges of Item Number, Structure Code, 
Category, and Account Set Code, select items by item status, and specify additional selection 
criteria using more item fields. 

• Category – to select items in categories that begin with or contain a string of characters. You can 
refine your selection based on ranges of Item Number, Structure Code, Category, and Account 
Set Code, select items by item status, and specify additional selection criteria using more item 
fields. 
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• Account Set Code – to select items with codes that begin with or contain a string of characters. 
You can refine your selection based on ranges of Item Number, Structure Code, Category, and 
Account Set Code, select items by item status, and specify additional selection criteria using 
more item fields. 

More on the “Search” option (most common option):  

• Select “Find Items by Search”. (Note that Find Items By defaults to the last choice used.) 

• Enter one or more words or word fragments in the next field to search multiple item tables and 
fields. (Note that the program scans all columns displayed in the Item Finder grid.) 

• You can filter for Active items only. 

• Search returns items and customer item numbers that contain the search string in any of the 
searched fields – for example, one record may have “Desk” in the Description field, where 
another may have it in the Comment 1 field. Both items will be displayed. 

Note: 

o If using the Search option, all of the word fragments must be present in one of the fields that 
are displayed on the screen. (For example, if you search for “desk lamp”, you will not see an 
item where only “desk” is in the Description field and only “lamp” is in the Comment 1 field.) 

Display:  

• The top grid displays the items matching the search criteria. The screen below shows “Desk 
Lamp” in the description of one item, and “Desk Lamp” in the comments of the second one – so 
both appeared. 

• The bottom grid displays the customer item numbers for the item selected in the top grid.  

  

• Click the Qty. Available column to see the location details, with the quantities on hand, on 
purchase order and on sales order. You can drill down further on these quantities. 

Selection:  

• Double-click an item in the top grid to select and add the item to the order. 

• Double-click a customer item number in the bottom grid to enter the item number and the 
customer item number into the order form. 
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Selecting columns to display – and scan – in the Item Finder  

Choose File > Settings in the Item Finder window to change column settings.  

 

• The current columns that are displayed appear in the right-hand column.  

• Highlight columns that you want to add in the left-hand column and click the Include button. 

Note: 

• Settings apply to the currently selected tab. For example, if you want to change the columns 
on the Manufacturer’s Item Number tab, choose the tab first, and then select File > Settings. 

• Only the “Included Fields” are used for searching. For example, if you do not include the 
Comments 1 field, the program will not scan the comments. Also note that fields like the “Price” 
will affect performance because the program calculates the price for the current customer in order 
to display it in the item results. If search is slow, remove columns that you don’t need. 

All of the possible columns are shown below. Note that optional and calculated fields are also available 

for inclusion – for example, the Item’s Color and Qty. Available for Sale. 
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Searching for Items on the Manufacturer’s Item Numbers Tab 

Note:  The Manufacturer’s Item Number tab will not appear unless you have a license for the Enterprise 
version of Productivity Tools. 

Search for manufacturer’s item numbers is a Productivity Tools Enterprise feature. 

 

• The Manufacturer’s Item Number Finder appears with “Search” selected by default. This is the 
most common way to look up items by manufacturer’s item numbers. 

o Type a partial item description or item number in the text field, optionally select Active Items 

Only, and press Enter to immediately search for manufacturer’s item numbers. 

• Alternatively, select “Manufacturer’s Item Number” or “Manufacturer’s Item Description” for 
searching. 

The Item Finder on the Manufacturer’s Item Number tab provides 3 search options: 

• Search (most common option) – to search for words or word fragments in manufacturer’s item 
text fields (the manufacturer’s item number or the manufacturer’s item description).  

This search works like the Order Number and Customer Number SmartFinders. 

• Manufacturer’s Item Number – to select items using part of the manufacturer’s item number.  

  

You can specify that the item number starts with or contains the string that you enter. 

• Manufacturer’s Item Description – to select items using part of the manufacturer’s item 
description. As with the item number, you can specify that the item description starts with or 
contains the string that you enter. 

• Note that the “Search” choice automatically looks in all fields that appear as columns in the grid – 
such as the manufacturer’s item number and the manufacturer’s item description fields.  
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Using the Line Finder 

The Extended Order Entry Line Finder window lets you quickly find any order detail line in a large order 
by item number, item description, item comments, picking sequence, location, manufacturer, or other item 
fields. 

Click the Line Finder button to display the Line Finder pop up window.   

• Choose the order in which to display order items in the Line Finder. 

You can list items by item number, location, or customer item number. The example below 

displays lines by item number. 

• Choose the selection criteria for displaying order items in the Line Finder. 

For example, you can select items by item number, item description, item comments, picking 
sequence, or location. The example below selects item lines for a range of item numbers and the 
location. 

• Click the Load button to display the selected lines. 

• Double-click the line you want to view, or highlight the line and click the Select button at the 
bottom of the screen. 
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Customer Inquiry 

The Customer Inquiry button displays the TaiRox Productivity Tools Customer Inquiry screen – a 
convenient way to view all data related to the customer. Each tab focuses on an aspect of the customer’s 
data.  

You can also look up details for other customers while you are on this screen. 
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Calculating Expected Ship Date and Deliver By Date for Orders 

The Extended Order Entry program will automatically calculate the expected ship date and deliver by date 
on the order header and order details of each order, based on your company’s regular business days and 
any additional non-business days in your calendar – such as statutory holidays and closures for inventory 
counts. 

You set your company’s business days, and a table of additional non-business days, in the Productivity 
Tools Options program.  

 

• Set your company’s regular business days and additional non-business days on the Business 
Days tab in the Options program. 

 

The non-business days optional field is a table of upcoming dates when your business will be 

closed.  

Note:  if you update the dates in the non-business days optional field, you must restart the 

Extended Order Entry program for the new dates to be in effect.  

• Set the number of days from the order date to the expected ship date and deliver by date on the 
Order Entry tab in the Options program. 
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Customer Optional Fields Displayed on the Order Entry Screen 

If you use the Sage 300 Optional Fields module, you can display any optional fields from the A/R 
customer record on the right side of the Extended Order Entry screen. 

 

This lets you view notes concerning the account during data entry, and also view order requirements – in 

this example, one of the fields is “Require Purchase Order No.” 

• You specify which optional fields to display on the Extended Order Entry screen in the 
Productivity Tools Options program – on the Order Entry tab. 

 

Require Purchase Order Number on Orders 

Extended Order Entry includes an option to require users to include purchase order numbers on orders 
for all or for selected customers. You select this option in the Productivity Tools Options program. 
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If you use the option to force PO numbers on orders, but post an order that’s missing the PO number, the 
following message appears. 

 

Notes: 

• The program lets you require PO numbers for all customer orders, or only for customers with a 
“Yes” value for a specific optional field. For example, the Order Entry screen pictured above 
shows an optional field called “Requires Purchase Order No” where the value for the field 
determines if the PO number is required. 

• If a customer record does not include a value for the Yes/No optional field, the program will not 
require a purchase order number when you create an order.  

Setting Up the Option to Require PO Numbers on Orders 

In the following example, the program uses the Yes/No value in Optional Field “REQPONUM” (with a 

description “Requires PO Number on Orders and Shipments”) to determine whether customers require a 
PO number. 

• You choose the option and the optional field in the Productivity Tools Options program – available 
in the TaiRox Productivity Tools folder on the Sage 300 Desktop: 

 
(The General Ledger tab appears only if you have a license for TaiRox Productivity Tools Enterprise Edition.) 

• If you use the option to force PO numbers on orders – and the customer record includes the 
control field with a “Yes” value – the following message appears when you try to post an order 
that’s missing the PO number. 

 

• In this example, the “Requires PO Number . . .” field also appears at the top of the Optional Field 
list on the Order Entry scfreen. 

Note that the field appears on the Order Entry screen if: 

o It has been added to the Customer record in A/R. 

o It was added to the set of optional fields that are displayed in Order Entry (using the 
Productivity Tools Options program). 
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Display and Edit Optional Fields Inline in the Order Detail Grid 

If you have the Enterprise version of TaiRox Productivity Tools, you can display and edit optional fields for 
order details inline in the Extended Order Entry detail grid. 

 

You choose the option to display optional fields inline in the Productivity Tools Options program – 
available in the TaiRox Productivity Tools folder on the Sage 300 Desktop. 

Adding Detail Optional Fields to the Order Entry Details Grid 

• Select the Productivity Tools Options program. Note that you must be using TaiRox Productivity 
Tools’ Enterprise Edition to add optional field columns to the grid. 

• Choose the Order Entry tab and then select the extended transaction entry programs where you 
want to display optional fields. You can add optional fields to the detail grids in Extended Order 
Entry, Extended Shipment Entry, Extended Invoice Entry, and Extended Credit/Debit Note Entry. 

 

Set Up Other Restrictions and Preferences in TaiRox Options 

Extended Order Entry also includes other settings that you can select on the TaiRox Productivity Tools 
Options screen: 

• Warn if a PO is duplicated on an order or shipment. 

• Show unit of measure totals on the Extended Order Entry and Extended Shipment Entry screens. 

• Include the discount percent set for each order line and for the order as a whole. 

• Prevent orders from being posted if the Ship-To Location is blank. 

• Prevent users from entering or changing ship-to addresses. 

• Require a ship-to phone number on orders and shipments. 

• Default the quantity committed on orders to the quantity ordered for select customers. 

Setting Up Additional Order Entry Options in Productivity Tools Options 

• Select the Productivity Tools Options program. 

• Choose the Order Entry tab and then select the options you want – such as displaying a warning 
for dulicate PO numbers. 



Extended Order Entry Margin and Recent Cost Columns 

TaiRox Productivity Tools for Sage 300  16 

© 2009-2025 TaiRox Software Inc. All rights reserved.  

 

See the Productivity Tools Options User Guide for more information on each of these options. 

Margin and Recent Cost Columns 

Knowing item and order margins is important when margins are constrained contractually or when the 
most recent cost may be used rather than a price list. Extended Order Entry saves you time by displaying 
margin and cost data on the Extended Order Entry screen. 

Extended Order Entry's line detail grid includes 4 additional columns for margins and costs. These 4 

columns are also displayed when using the Order from History function on the Orders tab in the detail line 
grid. 

• Margin Percent  

• Markup Percent  

• Margin Amount  

• Most Recent Unit Cost (based on P/O receipts).  

You can also include line discounts in margin and markup calculations by selecting the option to “Subtract 

Discount from Margin and Markup Calculations” in the Productivity Tools Options program. 

Note: Users must have Order Entry Item Cost Inquiry rights in order to see the margin columns. 

To view Order Margin information for the whole order and for individual lines:  

• Click the Order Margin button (below the item quantities) at any time to see the margin on the 
order as a whole. 

 

 

Users with an Enterprise license for TaiRox Productivity Tools will also see a Discounted Unit Price, 

which is calculated by dividing the Discounted Ext. Amount by the Quantity Ordered. 

 

https://www.tairox.com/downloads/suite-productivity/Options%20User%20Guide.pdf
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Edit Kit Details Using the Components Button 

Some businesses have kits where components or prices change with almost every order, and it is 
impractical to have each variation be a different kit number.  

Edit Kit Details provides a way to edit kit details – right inside an order – without creating new kit 
numbers.  

• You can add or delete kit components and change the component item quantities.  

• You can edit detail line optional fields. 

• And you can change component unit prices, calculate a new kit price, and enter the new kit price 
into the order detail line. 

To change kit component details and pricing: 

• Click the Components button on the Extended Order Entry screen. 

 

• Click Yes when the confirmation message appears to add or delete kit components or change 
component quantities, pricing, or optional fields. 

Click No to change weights, lots or serial numbers. The program will display the Sage 300 
Components form. 

 

Important Note #1: The Components button provides access to two different forms. 

o Click the Yes button to display the TaiRox components form to change quantities and pricing 
and to add or delete component items. 

o Click the No button to display the Sage 300 components form to change weights, lots, or 
serial numbers. 

If the kit item has been shipped, the Sage 300 form will be displayed. 

• Use the Kit Unit Price field at the top of the form to change the unit price of the kit. 
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The Kit Unit Price will be automatically updated if you: 

o Add or delete kit components. 

o Change the kitting quantity for any component. 
o Change the component unit price or the extended component price. 

• Edit optional fields information for the kit in the top grid. 

• In the bottom grid, you can: 

o Change the number of component items in the kit – the Kitting Quantity. 
o Change the unit price of each kit component – the Component Unit Price. 
o Override the calculated total price for this component (override the kitting quantity x 

component unit price) – the Extended Component Price. 

Changes made in the bottom grid will update the Kit Unit Price at the top of the form. 

 

Note that the price columns in the grid above have been moved from the end of the grid to a position  
beside the Qty. Ordered field. 

• The Kit Unit Price for the kit is automatically recalculated as you change components, and the 
resulting calculation may represent a new unit price for the kit as a whole.  

If necessary, you can change the Kit Unit Price after editing item components. 

• Click Save, and then click the close button to update the component quantities and update the 
unit price for the kit.  

If you DO NOT click the Save button first, one of the following messages can appear: 
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This message appears if you changed kitting component items or component item quantities – 
even if you also change prices.  

o Click Yes to update the order with the new component changes. 

 

This message appears if you changed pricing only, and the Kit Unit Price displayed at the top of 
the screen does not match the kit price on the order detail line. 

o Click Yes to update the order with the new kit unit price changes. 

Important Note #2: You cannot change quantities or pricing for posted order lines. 

The ability to change kit details operates within restrictions imposed by Sage 300 objects.  

Once an order is posted, the TaiRox component form cannot be used to change quantities on an 
existing kit line.  

However, you can delete a line after posting and add a new kit line – then change quantities on 
the new line.  

If you try to change quantities or prices on a posted kit line, the following message will be 

displayed. 

 

Important Note #3:  Pricing data on the Kitting Components form is NOT saved. 

The Kit Unit Price, Component Unit Prices, and Extended Component Prices are not saved when 

you close the Kitting Components form. They are used ONLY during the session to help you 
calculate a new Kit Unit Price and update the order detail line. 

Each time you open the Kitting Components form, the program will read and display the unit 
prices from the I/C Item Records and calculate a Kit Unit Price at the top of the form based on the 
calculated Extended Component Prices.  

If you previously changed the Kit Unit price, and you reopened Kitting Components form, 

you will see the following message – even if you made NO price changes. 

 

Do NOT click the Yes button unless you want to revert to reset the Kit Unit Price. 
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Using the Enhanced BOM Components Popup 

Click the Components button at the bottom of the screen to see the list of components in a bill of material 
and to check component availability if you need to build more BOM items.  

The BOM Components screen displays all components in a BOM and displays the quantities of each 
components ordered and shipped for this order, as well as the quantities on hand and available for each 
component at the current location in case you need to build more BOMs. 

It also displays (at the bottom of the screen) item quantities on hand, on sales order, on purchase order, 

committed, and available for the current location and all locations for the item you select in the grid. 

To view BOM Components and Quantities: 

• Highlight the order line for the BOM and click the Components button to see BOM components 
and component quantities. 

 
 

 

• The Qty Ordered column shows the number of component items are included in this order. 

• The Qty On Hand shows the number of component items in inventory (not including items that 
have already been assembled in BOMs). 

• Items in yellow have insufficient quantities on hand to build new assemblies if you need them. 

• In this case, the top item in the BOM Components list above is a subassembly BOM. Click the 
Details button or double-click the line in the grid to display the subassembly components. 

• You can also see that the top line has zero quantities on hand – again, this is not including 
subassemblies that have already been assembled in BOMs. 

The quantities for all locations are displayed at the bottom of the screen – in this case, also for 

the subassembly in the top line. You can select other lines in the grid to view quantities at all 
locations. 
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Quick Forms Printing (O/E Forms Button) 

The O/E Forms button lets you quickly print a number of order and shipment-related forms without posting 
an order or navigating to another window. See the next section – Print Picking Slips Fast – for an even 
faster way to print picking slips directly. 

  

To print OE forms 

• Click the O/E Forms button. 

The following form appears. Click the buttons on the right to use the Sage 300 printing functions 

and the Productivity Tools Email Packing Slip function.  

 

For quotes, the form will be pre-populated as follows: 

 

• You must select a shipment number for the Print Picking Slip and Email Packing Slip functions.  

By default, the Last Shipment Number (displayed at the top of the Extended Order Entry screen) 

will be used unless you change it.  



Extended Order Entry Quick Forms Printing (O/E Forms Button) 

TaiRox Productivity Tools for Sage 300  22 

© 2009-2025 TaiRox Software Inc. All rights reserved.  

 

Selecting the Email Packing Slip choice 

Productivity Tools lets you email customers packing slips for each shipment. When you click the 

Email Packing Slip button, the following form appears: 

 

o Select the Crystal report form for packing slips. 

o Confirm the shipment number. By default, this is the Last Shipment Number for the order 
(displayed at the top of the screen). 

o Select the Message for the Packing Slip. You can edit messages using the O/E E-mail 
Messages program, or click the Zoom button beside the Message ID field to load the form. 

o Select what you want to appear on the packing slip: serial/lot numbers, kit component items, 
or BOM component items. 

o Specify an email recipient or select the customer or ship-to email addresses for sending 
packing slips. The customer and ship-to email addresses come from the A/R customer 
account. 

If you choose “Email Address Entered”, enter the recipient’s email address. 

You can separate multiple email addresses with a semi-colon, comma, or blank space. 

For more information on emailing packing slips, see the Email Packing Slips User Guide. 
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Print Picking Slips Fast 

Extended Order Entry lets you streamline the printing of picking slips when you need to print large 
numbers of them as quickly as possible.  

Use the Settings choice on the Extended Order Entry File menu to select picking slip default settings, so 
you don’t need to answer the setup questions in a pop-up dialog box:  

 

 

• Select the first checkbox at the top of the form to change picking slip printing behavior. 

• Choose the Print Destination for picking slips. These settings bypass the setup and print picking 
sequence dialogs. 

o Choose the Preview setting to do a final preview before printing 
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Quick PJC Entry 

To speed up data entry, Extended Order Entry will default inserted lines to the previous entry's selections 
for Contract, Project and Category when multiple lines use the same selections.  

The following form shows how the order form appears immediately after pressing the Insert key to create 
the second line (with default values for the Contract, Project, Category and Cost Class fields): 
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View Order Prepayments 

Although the Order Entry screen lets you add a prepayment to an order, Sage 300 doesn’t provide a way 
to view the prepayments that have been entered for orders. 

The TaiRox Prepayments button on the right side of the Extended Order Entry screen lets you view all 
prepayments entered for an order using the Order Entry screen or using the Accounts Receivable Receipt 
Entry screen.  

To view order prepayments:  

• Click the Prepayments button at the bottom of the screen. 

  

• The program displays a pop-up form that lists all prepayments for the order – 1 in the following 
example: 

 

In this example, the prepayment is for one half of the order amount. 

• Click the Batch Number or Batch Entry column heading to drill down to the receipt entry in 
Accounts Receivable. 

Note that you cannot drill down to the order from this screen because the order is already open. 
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Create Purchase Orders 

TaiRox Create Purchase Order provides a flexible and robust way to create POs from orders or quotes.  

Where Sage 300 lets you blindly create purchase orders from orders, TaiRox extends this functionality by 

letting you preview the inventory items on-screen and edit item quantities, vendors and other data before 
you create the PO. 

Create Purchase Order: 

• Lets you create new POs or add lines to existing POs. 

• Lets you add PO description and reference information for the PO. 

• Lets you add Order Comments and Instructions to PO Comments and Instructions. 

• Provides default settings to control reference/description field defaults: Blank, Order Number, etc. 

• Provides settings to control the default selection (yes/no) for stock and non-stock items.  

• Creates POs for component items of Kits and BOMs – displaying item quantities for BOMs within 
BOMs. 

• Enables optional field merging for the PO, for PO lines, and for Kit/BOM items. 

• Displays status messages when there is no vendor for an item. 

• Creates multiple or combined purchase orders. 

• Provides convenient drill-down to purchase orders after creation. 

• Lets you cherry-pick POs for creation. 

• Lets you print new POs after they are created. 

Creating Purchase Orders 

Click the Create Purchase Order button at the bottom of the Extended Order Entry screen. 

Note:  The button is greyed out unless the OE order or quote is Posted, Active, and not On Hold. 
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A new window appears to show you the purchase orders that will be created from the items on the order 
or quote, and let you change how you want to create the POs. If one of the items on the order is a Kit or 
BOM, the individual component items will appear on the Create Purchase Orders form, as below: 

 

Use the scroll bar at the bottom of the screen to display more information fields, including item quantities 

at the current location and at all locations. 

Sage 300 lets you create nested BOMs where one or more of the items in a bill of materials is also a 

BOM. The following example shows how Create Purchase Orders displays items for nested BOMs. 

 

• Line 2 of the order is for 10 units of item A2(IMAGE-1500)G – which is a BOM that inludes nested 
BOM F3(HUNTS-2500)T.  

• The window with the green border shows all components of A2(IMAGE-1500)G. 

• The nested BOM items are listed after all other BOM items – and show properly adjusted 
quantities.  

For example, the order included 10 units of BOM A2(IMAGE-1500)G – and the nested BOM 

F3(HUNTS-2500)T includes 10 Pkgs of hanging file folders, for an PO quanity of 100 pkgs. 
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At this point, you can “cherry-pick” items for purchase order creation by double-clicking the Create PO 
column – then click the Create Purchase Orders button at the bottom of the form to generate POs. 

• Use the Select All and Select None buttons below the grid to set all items to Yes for Include on 
POs or No to exclude. 

 

• Double-click in the Create PO column to “cherry-pick” items for purchase orders: 

 

• Note in the grid above that there are four items. Lines 1 and 4 are for the same vendor, so they 
will be added to the same PO if you create POs for all items.  

• Click the Create Purchase Orders button at the bottom of the screen to create one purchase 
order per vendor. The form will be updated to show the PO Number of the newly created 
purchase orders and a message will appear stating the PO number – or stating how many POs 
have been created if it created more than one. 

      

• Click “Yes” to print new purchase orders, or “No” to continue.  

      

• If there is an issue creating a Purchase Order, the Status column will show the reason why the 
line items cannot be added to the purchase order (for example, "Item vendor not defined" when 
Using Item Vendor Information option).  

• The Create Purchase Order function will create a PO for an item that is a component of a Kit or 
BOM if that Kit/BOM is on the Sales Order. 

Note regarding Kit/BOM items:  IC6.2A and higher added support for a default BOM number.  

o If a default BOM number is defined for an item, and the BOM number is not set on the order 
line, the default BOM number defined for the item will be used to create a purchase order.  

o If there is no default BOM number, and the BOM number on the order line is not set, then the 
first BOM number will be used to create a purchase order. 

Changing how POs are created 

Choose vendor or existing purchase order 

Create Purchase Orders provides three main options for creating purchase orders: 
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• If you select Using Item Vendor Information, the item's preferred vendor (if there is one) will be 
the default vendor. If there is no preferred vendor, Vendor 1 will be the default vendor. 

o You can override the “Vendor Number” for each line if you choose.  

• If you choose “Using a Specific Vendor”, you must enter a Vendor Number.  

o The “Vendor Number” for each line is set to the Vendor Number you enter.  
o You can override the “Vendor Number” for each line if you choose.  
o If there is the same vendor number in every detail line, you override the automatically 

generated purchase order number by entering your PO number in the Purchase Order 
Number field. 

 

o If you override the Purchase Order Number and there is more than one vendor involved, 

an error message will appear: 

 

If you want to override purchase order numbers and multiple vendors are involved, 
select Yes/No in the first column of the grid (Create PO) and process the items one vendor at 
a time. 

• If you select "Using Existing Purchase Order", this determines a specific vendor and the same 
restrictions apply. 

 

o Use the Finder beside the Purchase Order Number field to select a PO. 
o Use the Drill Down button beside the Finder button to check the PO after you choose it from 

the Finder. 

Setting default PO descriptions, comments, instructions, and options 

You can select the default settings for options and for adding descriptions, comments and instructions 

to the new purchase orders. You can also change the settings for items as you select them.   

• Select File > Settings from the Create Purchase Orders screen to display default settings. 
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Shipping Quantities by Picking Sequence and Filtering Items 

The Ship button lets you display items in picking sequence order, item number order, or by location and 
filter them by ranges of order fields.  

For example, the following screens show items ordered by Picking Sequence and selected by Ship-Via 
code.  

Ship by Picking Sequence functionality is very useful when a large order has been picked and now the 
picked items have to be recorded as shipped.  

• The picking slip is in picking sequence order with quantities marked.  

• The order entry form is displayed in line number order.  

Matching and recording the entries from the picking slip is far easier when you list the items in 
picking sequence order.  

Item selection makes it easier to record partially shipped orders – in this case, where all items with the 
same Ship-Via code are in one shipment. 

• Click the Ship button to filter items and display them in the order you want –by location, item or 
picking sequence. 

• Order items by picking sequence, item number, or location. 

• Select items by picking sequence, item, location, price list, category, ship-via code, expected 
shipment date, date requested, backorder – or by order details optional fields (shown above). 

To use the Ship button to enter quantities: 

• Click the Ship button to display the Ship form. 

• Select the primary order for listing items. 

 

You can choose by Picking Sequence, Item, or by Location. 

• Choose the next sorting levels if you require a multi-level sort – such as by Item number and 
location. 

 

 



Extended Order Entry Shipping Quantities by Picking Sequence and Filtering Items 

TaiRox Productivity Tools for Sage 300  31 

© 2009-2025 TaiRox Software Inc. All rights reserved.  

• Choose a field for selecting a range of items. 

 

You can choose picking sequence, item, location, price list, category, ship-via code, expected 

shipment date, date requested, backorder – or order details optional fields. 

• Click the Load button to display selected items in the order you chose (in this case, items shipped 
by CCT displayed in picking sequence). 

 

• Enter quantities in the Qty. Shipped column.  

o You can enter the picked entries quickly using the Tab or Enter keys to move down the 

column. 

 

• Click the Ship All button at the bottom of the form to fill in the Qty. Shipped field for all items with 
the Qty. On Order.  

 

• When you close the Ship form, the Qty. Shipped numbers in the order entry form will be updated 
with the item quantities that you entered. 

Note:  

If you change the quantity shipped for an item with a serial number you may see a pop-up Sage 
300 windows like the following, allowing you to pick the serial number from the Finder. 
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Order from History 

The Order from History window lets you quickly create new orders for a customer based on previous 

customer orders. 

Using Order from History also tends to increase average order size while decreasing the number of 

orders processed per dollar of order. The result is lower shipping costs and other operational efficiencies.  

• Click the Order From History button to display the pop-up window showing previous orders.  

 

 

You can select items from previous purchase orders, update quantities, and copy the selected 

information into a standard line item row.  

Note: The Order from History button is only enabled once the customer has been entered on the form. 

To create a new order from prior ones using the Order tab on the popup form 

• Click the “Order from History” button.    The form that appears has two tabs: 

o The Orders tab lets you select items from previous orders.  

o The Sales History tab is similar, allowing selection of items.  

We’ll trace through a typical sequence for the Orders tab.   

• Use the range fields to select past orders for the customer, and then click the Load button. In this 
case, we’ve chosen orders since January 1, 2019. (You can add or remove fields from the range 
field dropdown lists using the Field Settings button – see below.) 
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. 

• Click any order in the top grid to see the order details in the bottom grid. 

• Click the Select All and Select None buttons at the bottom of the screen to include all or none of 
the items in the previous order. 

 

• Double-click the Include column to select individual lines (the Include column displays Yes). 

 

• Edit the Qty. Ordered column to change the quantities for the new order that you are creating. 
(The Original Quantity Ordered field shows the quantities from the previous order.) 

 

• When you have finished editing items from this order, click the Order button at the bottom of the 
screen to add the items to the new sales order. 

• Select another order from the top grid, choose the items that you want to order, enter the new 
quantities, and again click the Order button. 

• Click the Close button when you have finished adding items from prior orders. 

 

The order screen grid will be populated with line items from the historical order 

If security is enabled and the user has Unit Price Override rights, then a confirmation and completion 
messages will appear.  
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Important Note:  Yes means use historical prices. No means that current pricing will be in effect. 

Use the “Field Settings” button to customize the list of fields for selecting orders: 

Click the Field Settings button to change the fields that appear in the “Select Orders By” dropdown 
lists on the Order From History screen.  

 

• The list of fields on the right are the fields that will appear in the Select Orders By dropdown.  

• To add a field to the dropdown list, select it in the list on the left, and click the Include button. 

Using the Sales History tab 

The Sales History tab allows a similar sequence of operations – selecting, editing of quantities and 

copying to the new sales order. 

 

• Select the range of item numbers, order numbers, order dates, PO numbers, or categories that 
you want to use as search criteria, then click the Load button. 

• See the steps listed above for including items from history on the new order. 
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Setting default descriptions, comments and instructions for included items 

You can select the default settings for taking descriptions, comments and instructions from the original 
orders. You can also change the settings for each item as you select them.   

• Select File > Settings from the Order From History screen. 

  

• Select the checkboxes if you want them to be included by default from the original sales orders.  

Item Quantities 

The Item Quantities feature lets you display item quantities available at all inventory locations – including 

locations in other companies – while entering an order.  

To display quantities for multiple locations and companies: 

• Select the Extended Order Entry > File > Settings menu choice to change the Item Quantities 
display settings. 

  

o Do Not Display – shows only total quantities and quantities for the current line item location 

– like the standard Order Entry screen. 

 

o Display on Entry Screen – includes a grid at the bottom of the screen that displays 
quantities at all locations, in the current company and any associated companies. 

 

o Display on Separate Screen – displays the item quantities at all locations in a separate 
window.  
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Click the All Locations button to move the Quantities in front of other windows (if hidden).  

 

The All Locations button appears at the bottom of the Extended Order Entry screen if you 
choose to display quantities on a separate screen. 

Item Quantities will be refreshed as you move to other detail lines.  

Selecting which companies and locations are displayed 

An administrator must first set up the Sage 300 company databases and locations that are displayed in 

the Item Quantities grid. 

• Go to TaiRox Productivity Tools > Options, and click the Item Quantities tab. 

 

o Use the Insert and Delete keys to add or remove locations and companies from the Item 

Quantities grid and to change the order that locations appear. 

• Note for Sage 2023 PU2 and higher:  Item data will NOT appear unless the user ID and 
password have sufficient permissions to access the Sage 300 Vault database as well as the 
individual company DBs. 

Each user can customize the item quantities grid by hiding and moving columns to suit their own needs. 

For example: 

• You can hide the Database ID and Name columns if all locations are in the same Sage 300 
company.  

• You can also hide the Item Description and Stocking Unit if these are the same at all locations. 
Hide and re-arrange columns by dragging and dropping. 
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BOM or Kit – Use as Default 

Sage 300 Inventory Control has a "Use as Default" setting for BOMS and Kits, as shown here: 

 

In Extended Order Entry, this setting causes the BOM number to be defaulted when the BOM item is 

added to an order. 

(By contrast, in Sage 300 Order Entry, this setting does not cause the BOM number to be defaulted.)  

Backorders 

The Backorders feature lets you display all items on backorder for the current customer – while entering 
an order.  

To display backordered items on multiple prior orders: 

• Click the Backorders button at the bottom of the screen: 

 

The Customer Backorders popup appears, and defaults to orders for the current customer 

number and a full range of order dates.  

 

• Click the Load button to display all orders for the current customer with backordered items. 

Or 

• Click the Customer Number button to look up a different customer using the SmartFinder. 

• Specify the range of order dates that you want to search.  

• Click the Load button to display orders with backordered items. 
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The program displays all orders with backordered items for the customer within the range of order dates. 

 

 

 

• Highlight an order in the top grid to view the backordered item details in the bottom grid. 

• Double-click the order number – or click the Order Number column heading – to drill down to the 
order using the Extended Order Entry program. 

• Double-click the item number in the bottom grid – or click the Item column heading – to drill down 
to the item details using the Extended Inventory Items program. 

Using the SmartFinder to Look Up Customer Numbers: 

• Click the Customer Number button to look up a different customer using the SmartFinder. 

 

• Enter part of a name or address (or contact phone or email address) and click the Find button. 

 

In this example: 

o We entered “ron” in the Search field and pressed the Enter key to search for Ronald Black. 

o The program got 4 results, 2 with “Ronald” in the Customer Number field, and 2 with 

“Toronto” in the city field. 

See SmartFinder – Customers for more information on using the customer SmartFinder. 
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Update Order 

The Update Order functionality lets you make multi-faceted changes to an order – affecting multiple detail 
lines and order quantities. 

• Open the order that you want to change, then click the “Update…” button to display the Update 
Lines window for updating orders.  

 

 

The Update Lines screen lets you select from twelve different update procedures:  

 

Each choice has appropriate options.  

When you click the Process button, the program displays all changes in the window as it 

processes the order lines. It will also display a message if no changes are made. 

Updating an Order Kit Number 

 

• Select Update Order Kit Number from the dropdown list. 

• Use the Finder to select the Kit Item Number. 

• Select the current “From” kit number and the new “To” kit number. 
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• Click the Process button and select Yes when the confirmation message appears. 

 

Depending on your permissions, you may need to have price changes for a different kit number 
approved by a supervisor. 

The program will display progress messages as it updates lines and tell you when it is finished (as in 
the screen above). 

Note:  To change kit details, Update Order deletes the kit detail line from the posted order and then 
adds a new kit line with the appropriate changes – because Sage 300 does not allow it to change the 
details on a posted kit line.  

However, if an order has been partially shipped, the kit order lines cannot be deleted – this is also 

a restriction imposed by Sage 300 business logic – and the program will display an error message. 

To change kit details on a partially shipped order: 

1. Change the Qty. Ordered for the kit item line to 0.  

2. Insert a new order line, and specify the new kit number. 

Updating an Order BOM Number 

 

• Select Update Order BOM Number from the dropdown list. 

• Use the Finder to select the BOM Item Number. 

• Select the current “From” BOM mnumber and the new “To” BOM number. 

• Click the Process button and select Yes when the confirmation message appears. 

 

Depending on your permissions, you may need to have price changes for a different BOM 
number approved by a supervisor. 

The program will display progress messages as it updates lines and tell you when it is finished (as in 

the screen above). 
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Updating Item Expected Ship Date 

 

• Select Update Item Expected Ship date from the dropdown list. 

• Specify if this change is for a specific item, a range of items, or all items. 

 

o For a Specific Item, choose the Item from the Finder. 
o For a List of Items, click the Zoom button beside the dropdown, and add items to the list in 

the pop-up form that appears. 

 

Use the Finder to look up items. Use the Insert key to add new empty lines. 

o To Import a list of items from a spreadsheet, click the Import button. 

 

See Details for importing a list of items or item substitutions for spreadsheet format details. 

• Enter the new Expected Ship Date. 

• Click the Update Order Exptected Ship Date Also if this also changes the order date. 

• Click the Process button and select Yes when the confirmation message appears. 

 

The program will display progress messages as it updates lines and tell you when it is finished (as in 

the screen above). 

Updating Item Prices 

 

• Select Update Item Prices from the dropdown list. 
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• Specify if this change is for a specific item, a range of items, or all items. 

 

o For a Specific Item, choose the Item from the Finder. 
o For a List of Items, click the Zoom button beside the dropdown, and add items to the list in 

the pop-up form that appears. 

 

Use the Finder to look up items. Use the Insert key to add new empty lines. 

o To Import a list of items from a spreadsheet, click the Import button. 

 

See Details for importing a list of items or item substitutions for spreadsheet format details. 

• Choose the price list that you are using for the updates. 

• Click the Process button and select Yes when the confirmation message appears. 

 

The program updates prices for the items you specified to the prices on the price list. 

Substituting Items 

 

• Select Substitute Items from the dropdown list. 

• To specify the substitute items list, click the Zoom button beside the dropdown, and add “From” 
items (or kits/BOMs) and “To” items (or kits/BOMs) to the list in the form that appears. 
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Use the Finder to look up items. Use the Insert key to add new empty lines. 

• To Import a list of items from a spreadsheet, click the Import button. 

 

See Details for importing a list of items or item substitutions for spreadsheet format details. 

• Choose whether to “Only Substitute Items On This Order That Have Not Been Shipped.” If this 
option is selected, a line that is partially shipped will not be touched. 

• Choose whether you want to “Retain Existing Line Item Unit Price.” 

• Click the Process button and select Yes when the confirmation message appears. 

 

Depending on your permissions, you may need to have price changes for items approved by a 
supervisor. 

The program will display progress messages as it updates lines and tell you when it is finished. 

Updating Customer Addresses 

 

• Select Update Addresses from the dropdown list. 

• Choose which addresses you want to update – customer bill-to address or ship-to address. 

• Click the Process button and select Yes when the confirmation message appears. 

 

The program updates the address from the customer record. 

Updating the Item Deliver-By Date 

 

• Select Update Update Deliver By Date from the dropdown list. 
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• Specify if this change is for a specific item, a range of items, or all items. 

 

o For a Specific Item, choose the Item from the Finder. 
o For a List of Items, click the Zoom button beside the dropdown, and add items to the list in 

the pop-up form that appears. 

 

Use the Finder to look up items. Use the Insert key to add new empty lines. 

o To Import a list of items from a spreadsheet, click the Import button. 

 

See Details for importing a list of items or item substitutions for spreadsheet format details. 

• Enter the new Deliver By Date. 

• Click the Update Order Deliver By Date Also if this also changes the date for the order. 

• Click the Process button and select Yes when the confirmation message appears. 

 

The program will display progress messages as it updates lines and tell you when it is finished. 

Committing Quantities 

 

• Specify if this change is for a specific item, a range of items, or all items. 

 

o For a Specific Item, choose the Item from the Finder. 

o For a List of Items, click the Zoom button beside the dropdown, and add items to the list in 

the pop-up form that appears. 
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Use the Finder to look up items. Use the Insert key to add new empty lines. 

o To Import a list of items from a spreadsheet, click the Import button. 

 

See Details for importing a list of items or item substitutions for spreadsheet format details. 

• Click the Process button and select Yes when the confirmation message appears. 

 

The program will display progress messages as it updates lines and tell you when it is finished. 

Uncommitting Quantities 

 

• Specify if this change is for a specific item, a range of items, or all items. 

 

o For a Specific Item, choose the Item from the Finder. 

o For a List of Items, click the Zoom button beside the dropdown, and add items to the list in 
the pop-up form that appears. 

 

Use the Finder to look up items. Use the Insert key to add new empty lines. 

o To Import a list of items from a spreadsheet, click the Import button. 

 

See Details for importing a list of items or item substitutions for spreadsheet format details. 
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• Click the Process button and select Yes when the confirmation message appears. 

 

The program will display progress messages as it updates lines and tell you when it is finished. 

Changing Salesperson Code 

 

• Specify the From and To salesperson codes. 

 

o Use the Finder to look up salespeople. 

• Click the Process button at the bottom of the form and select Yes when the confirmation message 
appears. 

 

The program will display the following messages when it performs the update. 

 

Zeroing Quantity Ordered For Items Not In Stock 

  

Note:  This choice reduces quantities to zero on orders where the items have zero quantity on hand 
at the location specified on the detail line. 

• Specify if this change is for a specific item, a range of items, or all items. 
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o For a Specific Item, choose the Item from the Finder. 
o For a List of Items, click the Zoom button beside the dropdown, and add items to the list in 

the pop-up form that appears. 

 

Use the Finder to look up items. Use the Insert key to add new empty lines. 

o To Import a list of items from a spreadsheet, click the Import button. 

 

See Details for importing a list of items or item substitutions for spreadsheet format details. 

• Click the Process button and select Yes when the confirmation message appears. 

 

The program will display progress messages as it updates lines and tell you when it is finished. 

Changing Item Location 

 

This choice lets you change the item location for fulfilling orders. Note that the location can only be 

changed on order lines where the quantity ordered is greater than 0, and the quantity committed or 
quantity shipped is 0. 

• Specify if this change is for a specific item, a range of items, or all items. 

 

o For a Specific Item, choose the Item from the Finder. 

o For a List of Items, click the Zoom button beside the dropdown, and add items to the list in 
the pop-up form that appears. 
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Use the Finder to look up items. Use the Insert key to add new empty lines. 

o To Import a list of items from a spreadsheet, click the Import button. 

 

See Details for importing a list of items or item substitutions for spreadsheet format details. 

• Specify the “From Location” that you want to replace, and the new “To Location”.  

 

• Click the Process button and select Yes when the confirmation message appears. 

 

The program selects orders with the specified From Location on item lines. 

Details for importing a list of items or item substitutions 

• Click the Import button at the bottom of the item list popup form and select the spreadsheet 
containing the item list. The imported list will replace the current list of items. 

• Use the Insert key to add more rows to the list. 

• Use the Delete key to remove items from the imported list. 

• Click the Reset Defaults button to delete all items from the list. 

Import format: 

You can find sample import files in directory \Sage300\XL61A\Documentation. 

Note:  The Excel Spreadsheet for an item list (Items.xlsx) is a single column with “ITEMNO” as the 
column heading in the first row.  

 

The Excel Spreadsheet for an item substitution list (ItemSubstitutes.xlsx) must have at least these 

four columns. The program will ignore any other column names. 

 

• Item numbers can be formatted or unformatted. 

• All other columns are ignored. This means that you can add item descriptions and notes to your 
spreadsheet without affecting the file import. 
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